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TIPS Carlson Software 2011 Installation Instructions

Getting Started

® All TIPS software users must install the latest KeyServer Client on their machine prior to
installing new software versions. This is a requirement of the TIPS program to allow for
adequate collection of license and server usage statistics. The latest KeyServer Client is

available on the TIPS website http://www.tips.osmre.qgov/tips html/downloads.asp#K?2.

® Before starting the installation process, you will need the following:

» TIPS Carlson Software 2011 DVD or download from the Carlson website
(http://update.carlsonsw.com/updates.php?downloads=7b6a448ee20afa9bd6c9b842a78fb
dfb&product=Carlson ). File: Full version Carlson 2011 dated 01/17/2011 or later.

» Serial number, hosts file, and environment variable information provided with the OSM
TIPS distribution.

» Administrator credentials are required for program installation and first run of Carlson
2011.

» Though the vendor reports that it is not required, we recommend that the end user also
have administrator credentials for the software to function most efficiently.

General Overview

In order to properly install Carlson Software 2011, you must do the following:

1.

Install and launch the AutoCAD Map software prior to installing the Carlson product. If
Raster Design will be loaded on the user machine, it is required that it be installed and run
once also prior to installing Carlson 2011.
Use the instructions below to install Carlson Software 2011. These instructions are based on
installation onto AutoCAD Map 3D 2011 but can also be applied to installation on previous
versions of AutoCAD Map.
Ensure that the environment variable LSHOST and the HOSTS file are set according to the
documentation provided with the TIPS distribution notification. Note that if a previous
version of TIPS Carlson or SurvCADD software was installed, the required settings will have
already been applied (see page 20 for details on accessing the environment variable).
Launch Carlson Software 2011 while logged-in with Administrator credentials in order to
complete registration and automatically check for and install current updates. Current
updates can be accessed directly at:
http://update.carlsonsw.com/updates.php?downloads=7b6a448ee20afa9bd6c9b842a78fhd
fb&product=Carlson.
Have the end user log-in and follow the detailed instructions to set the default ‘AutoCAD
Map Classic’ menu and restore ‘Express’ and ‘Raster’ menu dropdowns (see instructions on
pages 14-19).

If you have any questions or difficulties, contact Tom Mastaller at (412) 937-2108 or
TMASTALLER@OSMRE.GOV; if Tom is unavailable, contact Tonya Mullins at (276) 523-
0042 x13 or TMULLINS@OSMRE.GOV.

Additional information (e.g., most recent installation instructions and installation FAQS) is
available on the TIPS CAD Software webpage http://www.tips.osmre.gov/CAD/default.htm.



http://www.tips.osmre.gov/tips_html/downloads.asp#K2
http://update.carlsonsw.com/updates.php?downloads=7b6a448ee20afa9bd6c9b842a78fbdfb&product=Carlson
http://update.carlsonsw.com/updates.php?downloads=7b6a448ee20afa9bd6c9b842a78fbdfb&product=Carlson
http://update.carlsonsw.com/updates.php?downloads=7b6a448ee20afa9bd6c9b842a78fbdfb&product=Carlson
http://update.carlsonsw.com/updates.php?downloads=7b6a448ee20afa9bd6c9b842a78fbdfb&product=Carlson
http://www.tips.osmre.gov/CAD/default.htm
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Initialize Carlson 2011 Installation

¢ You must have Administrator credentials to perform the installation (i.e.,You must be logged-in
as an administrator).

e If you have the TIPS Carlson Software 2011 disk, insert it into the appropriate drive. If the
installation does not start automatically, browse to and double-click on the DVD drive; if that
fails to launch the installer, navigate to the root directory of the DVD and double-click
‘Autorun.exe’. This opens the ‘OSM TIPS Carlson Software 2011 Installation DVD’.

e Click on Install Carlson 2011 to initialize.

e |t may take 45 seconds or more for the installer to load and initialize (If the installation fails to
initialize after a minute or so, navigate to the DVD root directory and double-click on the
installation file ‘InstallCarlson2011.exe’ to install.).

QSM TIPS Carlson Software 2011 Installatic

Click on Each '"Radio Button' to Initiate the Coresponding Action.
You Must Be Logged-n with “Administrator Credentials to [nstall the Software,

Adobe Acrobat Reader iz Meeded ta Display the Documents on This DVD.

f About This DVD | Disp!ay I_nformation About Thiz DVD
Distribution.
. . Dizplay the OS5k TIPS Installation Instructions
Installation Instructions for Fartson Saftware 2011,

il Dizplay the Carlzon Software 2011 Manual
Carlzon 2011 Marual | [Versicn 92720101,

RN OF i - Install Carlson Software 2011
f ﬁ]\" Instal Carson 2011 | 3 (Full Version 01-17-2011 / Build 110117).

| Instructions to Restore AutoCAD Raster Design
ﬁ fiscteiesoubleniiH ‘Raster' Menu on Carlson Software 2011,
\‘\JunraC/

< Back

or
¢ If you obtained the software via download, navigate to the location where the full version EXE
file was saved and double-click on the file (i.e., Carlson2011.exe) to initialize the installation
program.
e The Carlson 2011 installation process will initialize... (Note: If an “Open File — Security
Warning” or “User Account Control” window appears, click Run or Yes and continue.)

arlson - InstallShield Wizard

LEs

p s prepaiing the Ins nrsnmw e
uigh the fest of the sotup process, Plea:

()
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e Click Next to continue with the installation.

Carlson 2011

Welcome to the InstallShield Wizard for Carlson 2011

¢ Back @ Cancel

—

Review and, if agreeable, click Yes to accept the licensing agreement.

License Agreement
P 2ad the following |

Download the original attachment

License Agreement

Copyright 1932-2010 Carlzon Software 4ll Rights Rezerved
CAUTIOM! READ THIS MOTICE BEFORE USING SOFTWARE

Plzasze read the following Software License Agreement before using the SOFTWARE. Using
thiz SOFTWARE indicates that you have accepted itz terms and conditions.

Carlson 2011
END-USER LICENSE AGREEMENT FOR CARLSOMN SOFTWARE
IMPORTANT-READ CAREFULLY: This Carlzon Software End-User License dgreement

["EULA"] is a legal agreement between you [sither an individual or a single entity) and Carlson
Software, Inc for the Carlzon SOFTWARE accompanying this ELLS, which includes

InstallShield
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o Select the applicable platform (i.e., 64-bit or 32-bit) version that you want to install (in this case,
click on the circle next to 64-bit version of AutoCAD...).
e Click Next to continue.

Select platform to usze

“w'hich platfarm would you ke ta install Ca

o [B4-bit
L

® InteliCAD enging built-in (6.6 and 7.0)

% Back ; Mewst > } Cancel

e Select the version of CAD software that you want to use with Carlson 2011 (in this case, click on
the circle next to AutoCAD / AutoCAD Map 2011).

e Click Next to continue.

Select CAD version
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e Enter the Serial number provided with the distribution.
e Click Next to continue.

Get Serial Number

ftwaare in order to continue.

’ < Back (ﬂiﬂb D

il

Verify the install path. The default ‘C:\Program Files\Carlson2011_ACAD11_Xxx’ is
recommended.

e Use Browse to change the default location if desired.
e Click Next to continue.

Setup will instal 011 in the fallawing folder.

Taoin thiz folder, click Mext. Toinstall to a different folder, click B
falder.

ation Folder

InstallShield Cancel
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Choose the preferred Setup Type:
‘Complete Install’ copies all files to the user computer.
‘Remote Install’ copies some files to the user computer and some to a network server.

The ‘Complete Install’ option is recommended (The ‘Remote Install’ option has not been tested
and is not supported by TIPS.).

Click Next to continue.

Setup Type

Sele

Verify the Carlson work directory. This is where the program will store drawing and data files
by default. The default ‘C:\Carlson Projects’ is acceptable.

Use Browse to change the default location if desired.
Click Next to continue.

Select Work Directory

: ahd data files

Browse...
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Verify the project settings directory. The default ‘C:\Carlson Projects\Settings’ is recommended.
Use Browse to change the default location if desired.
Click Next to continue.

Select Settings Directory

zed by default ko

Browse...

InstiaalIBhield l Cancel ‘

Review the information in this dialog box to ensure that all settings are as desired.
If changes are needed, click Back to revert to the appropriate screen(s) and revise as necessary.
Click Next to continue.

Start Copying Files

Fe: before copyir

Curment S

Praduct version: Carlson 20771 with AutoCaD 2010,2011
Modules selected: Bazic Carlzon 2011
Survey
Ciil
Geology
Hydralogy
Basic Mining
Underground Mining
Surface Mining
Field
Pairt Cloud

Matural Regrade
Install type: Full install
Carlzon 2011 Directary: C:%Program Files\Carlzon2011_ACAD11_<G4
Fragram Directory: C:\Program FilessCarlson2011_ACADTT_xB4NL5PY
Work Directory: C:\Carlson Projectsh
Exec Directony: C:%Program Files\Carlzon2011_ACADT1_=B4\EXECN

4

Cancel
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e Enter an optional CAD profile if the user or your office has specified one.
e The default (i.e., leave blank) is recommended.
e Click Next to continue.

Get Profile Hame

o optional CAD profile name to copy from. Leave blank to u

roric [

Inshal|Shield Cancel

e The installation will progress with files being copied...

Installing ‘

’ Inztalling
C:h ASupT emplate'cz] 1haze.dll

_ ~ Instaling

C:hCALSPACFG_SCAD fas

Cancel
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e When prompted, select the version of the Autodesk product that you would like to start with
Carlson 2011 (in this case, AutoCAD Map 3D 2011). This is dependent on what version of
Autodesk software is installed and was specified in the step at the bottom of page 4.

e Click Next to continue.

Select AutoCAD

e The installation will continue with additional files being copied...
e After file copying is complete, ‘Support and Updates information’ will be displayed.

e Click Next to continue.

Support and Updates information

InstallShizld Cancel
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e Click Finish to complete the installation.

InstallShield Wizard Complete

Dauble cli izan oh Haur d

InstallShield Cancel

e Click Finish to close the ‘OSM TIPS Carlson Software 2011 Installation DVD’.
e You may also want to close the DVD folder used to initiate the TIPS DVD installation routine
and / or ‘Exit’ any command window that may be open.

F Y
OS5M TIPS Carlson Software 2011 Installation DVD -

Click. on Each "R adio Button'' ta Initiate the Coresponding Action.
You Must Be Logged-ln with “ddminiztrator” Credentials ta Install the Software,

Adobe Acrobat Reader i Heeded to Dizplay the Documents on This DD,

Digplay Infarmation About Thiz DWD

eeul This DD Diztribution.

Display the 05k TIPS Installation [nstructions

Inztallation Instructions for Carlaon Softvare 2017,

[Fullersion 01-17-2011 / Build 110117,

Instructions to Restore AutoCAD Raster Design
‘Raster' Menu on Carlzon Software 2017

Carlsan 20711 Manual | Dizplay the Carlzon Saftware 2011 Manual
| Install Carlzon Saftware 2011
| Raster Design Menu Fix |

[Wersion 9-27-2010).
SRIENLOF
Jgé.@"ﬁ f % Install Carlsan 2011
|';|-; & |
=
k




1/25/2011 Carlson Software 2011 Page 11 of 21

Launch Carlson 2011 / Program Updates / Registration

Note: Before launching Carlson Software 2011, you must set the environment variable LSHOST
and the HOSTS file according to information provided with the TIPS distribution package. If a
previous version of TIPS Carlson software was installed, the required settings will have already
been applied. (See page 20 for details on accessing the environment variable.)

While still logged-in with Administrator credentials, launch Carlson Software 2011 from one of
the Carlson desktop shortcuts or from the MS Windows Start Menu.

pon -
Bf ©

201 2011 with ... Natural Re... Cloud 2011 ... Mining 201...

or

g Carlson Software
. Carlson 2010 with AutoCAD Map 3D 201
S . Carlson 2011 with AutoCAD Map 3D 201 3
B Carlson 2011 Movies ST
e P Carlson Civil 2011 with AutoCAD Mz
u Carlson Field 2011 with AutoCAD Mi| |
‘ Carlson Hydro 2011 with AutoCAD M
. Carlson Mining 2011 with AutoCAD
@ Carlson Natural Regrade 2011 with 4
-’ Carlson Point Cloud 2011 with Autor

Music

Network
Control Pan,

Devices and

| Carlson Projects
)" Carlson Survey 2011 with AutoCAD |
@ Check for Carlson 2011 Updates

B3 Reset User Prafile -

Back

The program will automatically check for main program updates upon the first run and weekly
thereafter (via internet connection).

If updates are identified during this process, it is recommended that they be installed to ensure
that the most current features are available to users. Simply follow the screen instructions to
accomplish this.

If users do not have Administrator credentials, consider selecting the box next to ‘Never check
again’ as non-Administrators would not be able to install future updates identified by the
program.

If no updates are available (as shown below), click Exit.

Connecting to Carlzon update server...

Mo update available, <=

Click Exit button.

Mo update iz available.

Click Exit to finish...

=22 [ Mever check again Options
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e AutoCAD Map 2011 / Carlson Software 2011 will proceed to open.
If the AutoCAD Map ‘Workspaces’ box appears, click OK to continue.

o |f the AutoCAD Map 3D ‘New Features Workshop’ box appears, select the circle next to
‘Maybe later’ to enable the user to be reminded of the New Features Workshop on the next
program launch and click OK to continue.

e Note that for 32-bit versions, a ‘Welcome Screen’ may appear instead of / in addition to ‘New
Features Workshop’; if that is the case, ‘Close’ it by clicking on the “X” at the top right corner of
that window.

- New Features
Too -based 2lbzor \ WQn(shop :

on cilihan labs

Task-base:| Rithon rla ; ; ] Getting Started Videos
‘bz, /

LA IpJrthe Jse-iterface

__;‘4ap Cassic Worssp Woulc
{commands or monu }mtgm
- ImrL Dala Using Dale Cunimeel

Attach o Basemap DWC

Query Mrtached Urawng:

- Vicw attrirettes af Twta

_ Lharge the Lo ar ard Linet/pe at LUats
Nl Lt i

Winel s Neow? | Boarmivsey Reamme e

Bl Procikes buuk | Tulunals

B “how thiz dialeq ar srartup
—_—

e The Carlson registration process will complete.
e Click OK to continue.

Carlson Software Message l&

Registration Completed

(o)
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e The Carlson 2011 ‘Startup Wizard’ window will open as a default. Click EXxit to close the
window and continue the software start-up.

e Note: The ‘Startup Wizard’ will not appear if the user had previously altered this setting and the
installation included copying the settings.

File  Edit View Draw  Inquiry  Settings  Points  Window  Help  Survey ~ COGO  Centerline

Current Map: Defaut - s
2 ]
=2
Data Siyle Table Tools EEEessEandnlss - [
[=}
‘ £F Draw Order _ g
- Map Base z =)
O Default 1
é. <
= Startup Wizard ===
o P
—q= Recent Files
=3
=l
8
A 12
2=
=)
i =
A
s
H
E
Open Recert Fie [C] Skip Startup Wizard Next Time
oot ) [hen €[ 82 ] D e ]
————
|

e Carlson 2011 will open to the module selected to initiate the program (in this case ‘Carlson Civil
2011%).

= -

File Edit  View Draw  Inguiry  Settings 2
RELIEELECIE IR \'::', T e e R @85 + S | 2

EméY 2 ediia/ @R W S 7@ S ByLaye || ——— Brlayer | —— B
% B4 B4 | s (A 5 B2

Surface Site nterline Profiles Sections Roads

E]

e If the User is already logged-in (i.e., as the Administrator), proceed to “Set ‘AutoCAD Map
Classic’ Menu:” on page 14.

e Go to the ‘File’ menu dropdown and click Exit to close the program (Click No when prompted
to save the drawing file).

Tools

View Insert Format

Ctrl+MN
wg e PREFERE vubiish Detaiis...
Drawing Utilities 3
Curre Send...
T Drawing Properties...
9 Drawing Histery
Data
Exit Ctrl+Q
=1
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Launch Carlson 2011 as the End User and Set Program Defaults
e Have the end user log-in.

e Have the user launch Carlson Software 2011 from one of the Carlson desktop shortcuts or from
the MS Windows Start Menu.

or

Carlson Software

.. Carlsen 2010 with AutoCAD Map 3D 201
.. Carlsen 2011 with AutoCAD Map 3D 201 3

- Carlson 2011 Movies

= Carlson Civil 2011 with AutoCAD M:

“ Carlson Field 2011 with AuteCAD M;

" Carlson Hydro 2011 with AutoCAD b

. Carlson Mining 2011 with AutoCAD

Ml Carlson Natural Regrade 2011 with 2

; Carlson Point Cloud 2011 with Auto!
. Carlson Projects

M Carlson Survey 2011 with AutoCAD I

@ Check for Carlson 2011 Updates

@ Reset User Profile

Back

Music

e

Computer

=)

Network

Control Pan

Devices and

1

| Search programs and files

o Ifthe AutoCAD Map ‘Workspaces’ box appears, click OK to continue.

o If the AutoCAD Map 3D ‘New Features Workshop’ box appears, select the circle next to
‘Maybe later’ to enable the user to be reminded of the New Features Workshop on the next
program launch and click OK to continue.

o Note that for 32-bit versions, a ‘Welcome Screen’ may appear instead of / in addition to ‘New
Features Workshop’; if that is the case, ‘Close’ it by clicking on the “X” at the top right corner of
that window.

o If the AutoCAD Map 3D ‘Autodesk Customer Involvement Program’ box appears, choose the
desired participation / non-participation option and click OK to continue.

e Ifthe Carlson ‘Startup Wizard’ box appears, click Exit to continue.

Set ‘AutoCAD Map Classic’ Menu:

e Set/ verify that Carlson 2011 is set to open to the ‘AutoCAD Map Classic’ menu.
e Select the ‘Settings” menu dropdown and click on Carlson Configure...

FeE s » ._

File Edit  View Draw  Ingui

DEH SR E G| XD DE
@ a22HLédm s 1 Set Project/Nata Folders...

30 Data Surface
|

Carlson Configure... E E:
Settings Explorer
Current Map: :1; Settings File Manager A,
| = 2 | __E D-E:' AutoCAD Options... —
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e Click General Settings...
-
Configure ﬁ
é General Settings... } l Drawing Setup... ]
[ Project/Data Faolders ... l [ Startup Settings ... ]
[ Survey Settings. . ] [ Surface Settings.. ]
[ Section-Profile Settings... ] [ Hydrology Settings... ]
[ Mine MNote Settings... ] [ Mining Settings... ]
[ Takeoff /SiteMet Settings. .. ] l Localization Settings... ]
[ Bit || Hp || Load || savess |
]
o Verify/ select AutoCAD Map Classic as the setting for ‘AutoCAD Menu.’
e Click OK to continue.
rGeneraI Settings r - . » e l ﬂ
General Object Linking Coordinate File Format
Use Startup Wizard [T Link Points with CRD File () Carlson Numeric Only
["] Generate Report Log (] Link Linework with Poirs (@) Carlson Alphanumeric
Save Drawing INI Files () Cand G Numeric Only
lgnore Zera Hlevs [ Link Labels with Linework
[ Use South Azmith () Cand G Alphanumeric
[ Link Linework with Centerines e
IUse Dview Twist Angle e yEl
[¥] Set DIMSCALE to Drawing Scale [¥] Group Point Entities () MS Access Database (LDT)
Set AUNITS to Drawing Angle Mode [ Mairtain CRD Histary File Remove Arcs
[7] Set PDSIZE to Symbol Size e —— Method By..
[¥] 5et INSUNITS to Unitless @) Max Offset () Chord Len
ie{ LTS:;»‘\LE on stacl;tup t;lf)dm.\n\ring Setup ) Aocess 97 © Access 2000 Max Offset 0.00010000
orce software-only Open river Chord Length
Coordinate Report Order Digtizer Seftings
Formatted Document Type PDF - Digitizer Puck Layout View
Report Viewer Auto Tablet On For Digtize Commands
AutoCAD Menu AutoCAD Map Classic - [] Auto Tablet Cff After Digiize Commands
7
—
e Click Exit to close Carlson 2011 configuration.
r hl
Configure CX
[ General Settings. .. ] [ Drawing Setup... ]
[ Project/Data Folders... ] [ Startup Settings... ]
[ Survey Settings... ] [ Surface Settings... ]
[ Section-Profile Settings... ] [ Hydrology Settings... ]
[ Mine Mote Settings... ] [ Mining Settings... ]
[ Takeoff /SiteMet Settings... ] [ Localization Settings... ]
—
( Bt D[ Hep || load || Saveds |
>
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Restore AutoCAD Express Tools and / or Raster Design Menus

e Launching Carlson 2011 using the program ‘Start’ menu or desktop shortcuts will set AutoCAD
with Carlson 2011 to open minus the ‘Express’ (i.e., Express Tools) and / or ‘Raster’ (i.c., Raster
Design) dropdown menus [The ‘Raster’ menu is only applicable if Raster Design has been
installed.].

e Once the menus are restored per the steps below, the settings will be preserved. The ‘Express’
and ‘Raster’ menus will be included no matter what program shortcuts or ‘Start’menu item is
used to open AutoCAD Map / Carlson 2011.

e Change to the AutoCAD Map menu by clicking on the ‘AutoCAD’ menu toolbar icon.

Format Tools Modify Map Parametric Help Express

Bylayer -

[¢ 7 v 2 x wI.EF G 2 Ef

e Note the resulting ‘AutoCAD Map Classic’ menu list.
If ‘Express’ and ‘Raster’ are not included as menu dropdowns, they must be restored.

e Note: The ‘Express’ and ‘Raster’ menus may not appear in the same position or order as shown
in the screen capture below.

|_ — Ca vil 20 | tf,a.

File Edit View Insert Format Toals Draw Dimension

‘Express’ Menu:

e To restore the ‘Express’ menu, simply enter ‘expresstools’ on the program command line and
press ‘Enter’ (i.e., type ‘expresstools’ and press the enter/return key.).

& e
M A [y { Layoutt /

L. 2Dl 3D |Vertical Exaggeration: [1x | ~ | Command |||

: (2cad baseload "ACAD™)
| ——

Command: prresstanls
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‘Raster’ Menu:

e Restoration of the ‘Raster’ menu is necessary only if AutoCAD Raster Design 2011 has been
installed. If Raster Design has not been installed, proceed to page 19.

e Enter ‘cuiload’ or ‘menuload’ on the program command line and press ‘Enter’.

|

4] 4] M)y {Layout1 J Layout2 [/

L. 20|l 3D|Vetical Exaggeration: [1x | ~ | Command ||

= Command: COMMANDLINE -
Command: MAPSTARTWSPACE

Command: cuiload

Tl ]| || S o e

e Use ‘Browse’ to navigate to the DVD drive root directory (a copy of the ‘Raster’ menu file
‘AecCo.cuix’ is located there.).
¢ Note that the file can also be found in the AutoCAD Raster Design 2011 program ‘Support’

folder (The default path would be ‘C:\Program Files\Autodesk\AutoCAD Raster Design
2011\UserDataCache\Support\AecCo.cuix’.).

r Y
&y Load/Unload Customizations . @

Loaded Customization Groups:

ACADIITE Unload
CARLSON

EXPRESS

MAPCLASSIC

TASKBASEDRIBBON
TOOLBASEDRIBBON

File Name:

e From the DVD root directory, highlight / select the file ‘AecCo.cuix’, and click Open.

r —
@ Select Customization File @
Look in: [EDVD Drive (E:) TIPSCarison2011 v] ] @ ¥ B Views v Toos ~
I Mame ° Date modified Type
e | AboutThisDVD 1/14/2011 114 PM  File folder
. Carlson2011_ARDMenuFix 1/14/2011 1:08 PM File folder
I Carlson2011Manual 1/14/2011 12:58 PM File folder
L..‘] . Carlson2011SoftwareBuild101208 1/14/2011 1:00 PM File folder
SlloticeTactertions 1/14/2011 1:14 PM File folder
] < Ffengl AecCo.cuix 2 6/21/2010 2:21 AM  AutoCAD Custon
- --'-'_—_——'-_—-
i
4 [ | 3
—,
File name: ‘lﬂ
—
Files of type: | Customization files (".cuix) +][ cancel
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e Note that the path to ‘AecCo.cuix’ is shown.
e Click Load to complete the menu load.
F
&) Load/Unload Customizations S

Loaded Customization Groups:

Unload
g
CARLSON
EXPRESS
MAPCLASSIC
| TASKBASEDRIBBON

TOOLBASEDRIEBON

[ Load ]
File Name: ‘

= R < <

Note that ‘AUTOCADRASTERDESIGN’ is now included in the list of ‘Loaded Customization
Groups’.

e Click Close to exit the ‘cuiload’ routine.

-
% Load/Unload Customizations l u

Loaded Customization Groups:

ACADBASE A
e (AUTOCADRASTERDESIGN il
CARLSON
EXPRESS |
MAPCLASSIC =
| TASKBASEDRIBBON
TOOLBASEDRIBEON

1

Load
File Mame:
E AecCo.cuix

Close Help
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e (o to the ‘File’ menu dropdown and click Exit to close the program (Click No when prompted
to save the drawing file).
e This completes installation and initial setup of Carlson Software 2011.

Ctrl+M

St
e, ViEW PREEERa v ubish etaiis...

£ Task

Curre Send...

Drawing Utilities *

f Drawing Properties..,

Drawing History

Exit Ctel+0)

Latest Program Version / Updates

e The latest program full version and updates / patches can be accessed / downloaded at any time
by visiting http://update.carlsonsw.com/updates.php; selecting the product ‘Carlson
Survey/Civil/Mining/Takeoff for CAD’; clicking Show Files; and then selecting product version
2011 for AutoCAD/IntelliCAD’.

Carlson Software is dedicated to
providing the finest software to Land

Surveyors, Civil Engineers, Mining
Engineers, and Land Development

Professionals

Select product you are looking for Carlson Survey/Civil/Mining/Takeoff for CAD -
. - P ——
Select product version 2011 for AutoCAD/IntelliCAD mj

Carlson download page

Before downloading any updates, go to Help-=About Carlson and verify that you are running
) Carlson 2011. If you are not, then do not download any updates from this page.

Please update your contact and notification preferences as needed:
or Visit subscribe page.

Name: Email: [l General News [l carlson Updates Update

Download File Size File Date Description

This is a full version Carlson 2011. The following modules are included: Survey, Civil, Hydrology, GIS, Basic
Mining, Geology, Underground Mining, Surface Mining, Natural Regrade, Field, Takeoff, Construction and
Point Clouds. This can be installed on AutoCAD 2000-2011 or with included Intellicad 6.6. Intellicad 7.0 is

1 Download 682,395,542 Jan-17-2011 also included, but remain in a beta/preview state, so it should not be used for production work. AutoCADs

2009-2011 are supported on 64-bit Windows. Carlson 2011 Serial number is required for installation.

Users on the active maintanance agreement can lookup their upgraded serial number by clicking here.

Filename: Carlson2011.exe

Carlson 2011 User Manual

Filename: Carlson2011_manual.pdf

This is a patch for users running Carlson 2011 on AutoCAD 2009 64-bit products.

Filename: Carlson2011Update_acadl7_x64_install.exe

This is a patch for users running Carlson 2011 on AutoCAD 2000-2002 products.

Filename: Carlson2011Update_acadl5_install.exe

This is a patch for users running Carlson 2011 on AutoCAD 2004-2006 products.

Filename: Carlson2011Update_acadl6_install.exe

This is a patch for users running Carlson 2011 on AutoCAD 2007-2009 32-bit products.

Filename: Carlson2011Update_acad17_install.exe

This is a patch for users running Carlson 2011 on AutoCAD 2010 and 2011 64-bit products.

Filename: Carlson2011Update_acadl18_x64_install.exe

Thin in = bk fre e e i Farlane A i A AR AR amd AR AT i s e e

2 Download 98,001,882 Sep-27-2010
3 Download 56,509,199 Jan-17-2011

Download 40,266,453 Jan-17-2011
5 Download 47,518,097 Jan-17-2011
5] Download 54,947,605 Jan-17-2011

7 Download 51,260,203 Jan-17-2011

IS
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Accessing Windows Environment Variables

Certain environment variables must be set to allow Autodesk products to obtain a license from the TIPS
license server. Specific information on the necessary variables is listed in the software distribution letter
mailed to your TIPS contact.

To access the environment variables:

e Navigate to Start Menu -> Control Panel -> System to open the ‘System Properties’ window
(In Windows 7, Start Menu -> Control Panel -> System->Advanced System Settings).

e On the ‘System Properties” window, select the ‘Advanced’ tab and click Environment
Variables.

Windows XP Windows 7 o=

System Properties

- .

5 —
System Restore Automatic Updates e [ Computer Name [ Hardw&‘ Advanced Dyslem Protection ‘ Remote‘
General | ComputerName | Hardware Advanced ——

‘You must be logged on as an Administrator to make most of these changes.
You must be logged on as an Administrator to make most of these changes.

Performance
Performance Visual effects, processor scheduling, memory usage, and virtual memory
Visual effects, processor scheduling, memory usage, and virtual memoty
: User Profiles
User Profies L Desktop settings related to your logon
Desktop settings related to your logon
e [ settngs.. | | |

Startup and Recovery

Startup and Recover
2 | System startup, system failure, and debugging information

System startup, system failure, and debugging information

C Environment Variables ! DEnot Repoiting < Environment Variables... | D)

=

e The lower half of the resulting Environment Variables dialog box is the area where you can add
new variables or edit existing ones.

r ™
Environment Variables M

User variables for

Variable Value
TEMP
T™MP
New... | [ Edit.. ][ pekte
System variables
Variable Value Il
I
ADSKFLEX_LICENSE_FILE -
ARCGIS_LICENSE_FILE
ARCGISHOME i
4 [ | +
New.. |[ Edt.. |[ Deete |

[ OK ][ Cancel ]
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Installation / Update Contacts

If you have any installation or update questions or difficulties, contact Tom Mastaller at (412) 937-2108
or TMASTALLER@OSMRE.GOV; if Tom is unavailable, contact Tonya Mullins at (276) 523-0042
x13 or TMULLINS@OSMRE.GOV.

Additional information (e.g., most recent installation instructions and installation FAQs) is available on
the TIPS CAD Software webpage http://www.tips.osmre.gov/CAD/default.htm.
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ALERT: TIPS will only support three versions of
Autodesk software prior to the 2010 release. If you
are using versions previous to 2007, you must
upgrade to versions 2007 or newer. Please contact
your TIPS Contact or Service Manager to obtain
the latest version.

New Course Offering in 2010

TIPS will be offering a new course, "CAD 400: Bridging
the CAD and GIS Gap in the SMCRA Workflow.” The
purpose of this course is to assist personnel in
integrating both CAD and GIS processes into SMCRA
workflows. Exercises will include use of Title Iv and v
data to show mechanisms of interoperability between
CAD and GIS. Check out the TIPS and NTTP class
survey for this new offering which will be held officially
in the calendar year 2010.

Available CAD Software

Autodesk Software Packages

AutoCAD Map 30 - The leading engineering GIS
platform for creating and managing spatial data. Also
provides all the tools available in “basic” AutoCAD.

AutoCAD Raster Design - Extends the value of scanned
drawings and maps, aerial photos, satellite imagery,
and digital elevation models. Take advantage of
raster-to-vector conversion, raster editing, and raster
data preparation capabilities.

AutoCAD Civil 3D - Used for the design, drafting, and
management of all types of civil engineering projects.

Autodesk Design Review - a FREE download: The all-
digital way to measure, mark up, and annotate 2D and
3D designs, all without the original design creation
software.

DWG TrueView - a FREE download: Accurately view,
plot and publish authentic DWG and DWF files. Can
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